
Q1.What are the four fundamental parts of computer?Explain with the help of a 

diagram? 

Ans:-The four fundamental pats of computer  

 

 

 Input 

 output 

 Processor(CPU) 

 Memory Unit 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Input Devices:An input device is any  hardware device that sends 

data to a computer,allowing you to interect it and control it. 

2. Output Devices:An output device allows data to be transmitted in 

a human friendly form. 

Input device 
Central Processing Unit 

Output 

Device  

control unit 

Arithmetic/logic 

unit 

Memory unit 



3. Processor:It is the portion of a computer that retrieves and 

executes instructions 

4. Memory Unit:It is a component of a computer sysyem.It is used to 

store data , instructions and information. 

Q2. Discuss about the classification of computers based on size and capacity. 

Ans:-The classification of computers based on size and computer are as follows:- 

1.Super Computer: 

 

a)It has thousands of processors. 

 

b)Because of their extraordinary speed,accuracy and processing 

power,super computer are well suited for solving high complex problems 

and huge amount of calculations. 

 

c)Example:JAGUAR, ROADRUNNER, etc. 

 

2)Mainframe Computer: 

a)They are very large often filling an entire room and can process 

thousands of millions insrtructions  per second. 

b)In a mainframe environment ,users connect to the mainframe through 

the many terminals wired to the mainframe. 

c)Mainframe are capable of supporting hundreds to thousands of users 

simultsaneously  

d)Some  of the functions perform by a mainframe include:Flight scheduling 

, Reservation and ticketing for an airline etc. 

e)Example : IBM mainframe Z13 , IBM system z9 mainframe. 

 

3)Mini computers :- 

 

a)Mini computers are smaller than mainframe 

b) These computers are less expensive. 



c) Sometimes  referred to as  Midrange Server or Midrange Computer. 

d)They are typically larger, more powerful and more expensive than 

desktop  computer. 

 

e) Midrange  computers are usually used by small and medium size business as 

their servers. 

f) Users connect to the server through a network by using desktop computers. 

4)Micro Computers : 

a)Micro computers are the most frequently used type of computer. 

b)It is known as Personal computer. 

c)A Micro Computer is a small computer designed to use by one person at a time. 

d)Desktop computers and laptops 

Q3. What is the meaning of computer generation? How many computer 

generations are defined? 

What technologies were /are used? 

Ans: Generation in computer terminology is a change in technology of a computer 

which were being 

used 

There are four computer generation such as 1st generation, 2nd generation, 3rd 

generation and 4th 

generation. 

In the first computer system, Vaccum tubes are used. 

Transistors are used in the second generation. 

Integrated circuit technology were used in the third generation. 

In the fourth generation microprocessors are used 

Q4: Differentiate between volatile and non- volatile memories. 

Ans:  



Volatile memory non- volatile memory 

1. It is a computer 
storage that 
only maintains its data 
while 
the device is powered. 
2. E.g. RAM. 
3. Primary memory has 
limited 
storage capacity and is 
volatile. 

1. It is a type of computers 
memory that 
has the capability to hold 
saved data 
even if the power is turned 
off. 
2. E.g. ROM, hard disk, 
floppy disk, etc. 
3. Secondary memory 
provides 
permanent storage of data 
and in bulk 
quantity 

Q5: Distinguish among system software, application software 

and open software on the basis of 

their features. 

Ans: System software: It is a type of software that is designed 

to run a computer’s hardware and 

applicationprograms. Software like operating systems, 

compilers, editors and drivers etc. come 

under this category. A computer cannot function without the 

presence of system software. 

Application software: It is a software created for specific purpose used 

by end users. It can be called 

an application or simply an app. 

Examples: word processors, accounting app etc. 



Open source software: It is a type of computer software in which 

source code is released under a 

license in which the copyright holder grants users rights to study, 

change and distribute the software 

to anyone and for any purpose. 

E.g. the Linux operating system. 

Q6: a) Create a file in MS–word to insert a paragraph about yourself 

and save it with file name 

“yourself”. Describe all steps involved in it. 

Ans: “Yourself” 

My name is Yumnam Johnson Mangang . I am 20 years old. I love to 

dance and sing. I am a student of 

science at IMPHAL COLLEGE, IMPHAL, MANIPUR. Currently I am 

learning computer CCA course at 

RGI TRAINING INSTITUTION. 

The steps involved are: 

 We click the Microsoft office button. 

 We select new. The new document dialog box appears. 

 We select blank document under the blank and recent section. I will 

be highlighted by 

default. 

 We click create. A new blank documents appear in the word window. 

 To save the document, we click again the Microsoft office button. 

 We select save as word document. The save as dialog box appears. 

 We select the location where we want tosave the document using 

the drop down menu. 

 We enter the file “yourself” for the document. 

 We click the save button. 



b)Write steps regarding followings 

 To change the font style 

 To change the font size 

 To change the font color 

 To highlight(in yellow) the line that reads “need to get IMS’s 

address”. 

b) Ans: Steps to change the font style: 

1. We select the text we want to modify. 

2. left click the drop-down arrow next to the font style box on the home 

tab. The font style dropdown menu appears. 

3. we move cursor over the various font styles. A live preview of the 

font will appear in the 

document. 

4. left click the font style we want to use. The font style will change in 

the document. 

Steps to change the font size 
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1. WE select the text we want to modify. 

2. 2. Left click the drop-down arrow next to the font size box on 

thehome tab. The font size 

drop-down menu appears. 

3. We move cursor over the various font sizes. A live preview of the 

font size will appear on the 

document. 

4. 4. Left click the font size we want to use. The font size will change in 

the document. 

Steps to change the font color 

1. We select the text we want to modify. 



2. Left click the drop-down arrows next to the font color box on the 

home tab. The font color 

menu appears. 

3. We move cursors on various font colors. A live preview of the color 

will appear in the 

document. 

4. 4. Left click the font color we want to use. The font color will change 

in the document. 

Steps to highlight the line 

1. We select the line that reads “needs to get IMS’s address” 

2. We click the highlight command and select yellow color in the font 

group on the home tab. 

Q7: Create a file in MS- Word for the following document and save it 

with file name ‘ms-word‘. 

Describe all steps involved in it. 

MS Word 

MS Word is a widely used commercial word processor developed by 

Microsoft. 

MS word is application software, which is capable of 

creating, 

editing, 

saving, 

printing any type of document 

Ans: MSWord 

MS word is a widely used commercial word processor developed by 

Microsoft. 

MS word is application software, which is capable of 

creating 



editing 

saving 

printing any type of document 

The steps involved are: 

1. We click the Microsoft office button. 

2. We select new. The new document dialog box appears. 
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3. We select blank document under the blank and recent section. It will 

be highlighted by 

default. 

4. We click create. A new blank document appears in the word window. 

5. We create the given documents from the question. 

6. We select the text “MS word” to change the font size by clicking on 

thefont size box on the 

home tab. 

7. We select the text “MS word” to change the font color into red by 

clicking on the font color 

menu. 

8. We select the text word processor and underline it by clicking the 

underline command in the 

font group the home tab. 

9. We select the text “MS word” to change the font style into italic by 

clicking italic command. 

10. We select the text we want to format as a list and click on the 

bullets command on the home 

tab. 

11. We change the font color of the text “creating” and “saving” into 

blue and red resp. by 



clicking on the font color command, again we select the text “and” and 

click on strikethrough 

command. 

12. We select the text “printing any type of document” and change the 

font style into bold by 

clicking on the font style command. 

13. We save the file name as “ms-word” by clicking the Microsoft office 

button and select save as 

14. We select the location where we want to save the document using 

drop-down menu 

15. We click the save button. 

Q8: Create a file in MS- word for the following document and save it 

with file name ‘equation’. 

Describe all steps involved in it. 

Equations 

x2 + y5=30 

z3+ q4=50 

a2+ b8=x2+ y8 

Ans: Equations 

X2+ y5 = 30 

Z3+ q4 = 50 

A2+ b8 =x2+y8 

The steps are: 

1. We create the given documents in MS-word 

2. We select the text where we want to format and click on the 

subscript and superscript 

command on the home tab 

3. We save the file name as “equation” by clicking the Microsoft office 



button and select save as 

4. We select the location where we want to save the document using 

the drop down menu 

5. We click the save button. 

Q9.Create a file in MS-word  for the following document and 

save with file name ‘equations’. Describe all steps involved in it. 

Equations 

x2 +y5=30 

z3+q4=50 

A2+B8=x2+Y8 

Ans:- Equations 

 X2+Y5=30 

                Z3+q4=50 

 A2+B8=X2+Y8 

 

The steps are: 

1.We create the given documents in MS- word. 

2.We select the text where we want to format and 

click on the subscript and supersubscript command 

on the home tab. 



3.We save  the file name as “equation” by clicking 

The Microsoft office button  and select serve as. 

4.We select the location where we want to save the 

document using the drop menu 

5.We click the save buttom. 

Q10. Create a file In MS-Word to insert a 

table in the document.Describe all steps 

involved in it. 

Ans:- 

          
          
          
          
          
 

The steps are:- 

1.We place our insertion point in the document where we want 

our table to appear. 



2. We select the insert tab 

3.We click the table command. 

4.We drag our mouse over the diagram squares to select the 

number of rows and columns in the table. 

5.Left click our mouse and the table appears in the document. 

6.We enter the text into the table. 

Q11.Create a following worksheet in MS- excel and save  it with 

name ‘book1’. 

Ans:-     Roll No.       Name        Marks 

                            1n1                        60 

                             2n2                        70 

                             3n3                         80 

                             4n4                         90 

                              5n5                        40 

                              6n6                         50 

                               7n7                        77 

                               8n8                         44 

                               9n9                         88 

                               10n10                     55 

                                    Sum                    654 

                              Average                    65.4 

                             Maximum                 90 

                            Minimum                   40 

 

 



Q12. Calculate the  following  things of a range(c2:c110 ) of data in the 

worksheet created in question no.10. 

-  The sum of the marks  using  AutoSum  in a range of cells (c2:c11) 

-   Average  of the marks in a range of cells (c2:c11) 

- Highest marks in a range of cells (c2:c11) 

-Minimum marks in a range of cells(c2:c11) 

 

 

 

 

Q13.a)Describe  various steps involved in the following 

 

- To  modify column width in a worksheet. 

- To modify the row height in a worksheet 

- To delete rows and columns of a worksheet. 

Ans:-  To modify column width of  a worksheet: 

      1)Select a column or a range of columns. 

Roll No. Name Marks 

1 
 

  

2   

3   

4   

5   

6   

7   

8   

9   



2) Select a home tab and in the Cells group, select Format. 

3) Click on Column width and type the width of a column. 

4)Select OK. 

Ans:- To modify column width of a worksheet: 

1.Select a column or a range of a columns. 

2.Select a Home tab and in the cells group, select format. 

3.Click on Column width and type the width for column. 

4. Select OK. 

 

To modify the row height of a worksheet 

1.Select a row or a range of  rows. 

2.Select a Home Tab and in  the cells group, select Format. 

3. Click on Row height and type the height for row. 

4. Select OK. 

To delete rows and columns of a worksheet. 

1.Select the cell  you want to delete within the column or row. 

2.Select Home Tab and in cells group click on delete sheet column or row. 

                                OR 

3.Select the desire row or column. 

Q13.b)Describe the following terms in the worksheet 

        -Absolute reference and relative reference in formula. 

        -Cell address 



Ans:-  Absolute Reference: 

         An Absolute reference in Excel means there is a fixed point of a reference 

applied to a cell or  a formula.This is so the return value will always stay the same 

no matter where the cell or formula moves to – within the same sheet or across 

the different sheet. 

 This refers to a fixed point  of reference  is a constant ,and involves the use of 

dollar sign $ in the formula (i.e.everyone is to receive the same bonus payout ,so 

the amount $1500 is constant in this situation) 

     

       Relative  Reference: 

        It is the default cell reference in Excel.It is simply the combination of column 

name or row number without any dollar sign.When you copy the formula from 

one cell to another the relative cell address changes depending on the relative  

position of column or row.C1,D2,E4 etc are examples of  relative cell references. 

Relative references  are used when we want to perform a similar operation on 

multiple cells and the formula must change according to the relative address of 

column and row. 

This refers to a relative point of reference is constantly changing and dollar sign is 

absent in the formula(i.e , when each unit price and quantity are difference 

variables,there’s no constant in the calculatiom) 

  Cell Address: 

A cell Address Is a combination of column letter and a row number that identifies 

a cell on a worksheet. 

For example, A1 refers to the cell at the intersection of column A and row 1;refers 

to the second cell in column B,and so on. 



        When used in formula , cell references help Excel finds the values the formula 

should calculate . For instance 

 To pull the value of A1 to another cell ,you use this simple formula:=A1 

To add  up the value in cells A1 and A2,you use this one:=A1+A2 

Q14.What tools are available to customize our  Powerpoint presentation? 

Ans:-Tools available to customize our powerpoint  presentation are: 

a)Perspector 

b)Pivot viewer 

c)Autodesk 3DS Max 

d)VisualBee PowerPoint Add-in 

e)Smart Art 

f)Animations and Transition 

g)Wordle 

h)CA coo 

i)Oomfo 

j)Clip champ 

b)Write the steps for the following action for the creation of PowerPoint 

Presentation. 

-Open a Blank Presentation. 

-Save the presentation as Lab1.pptx 

_Add a Title to the first slide :the name of your college. 

-Type your first name and last name in the subtitle section 



-Add a New Slide which has aTitle and Content. 

Ans:-      

             To open the blankpresentation: 

1) Open PowerPoint presentation using Run command (window key+R) 

2) Select the ‘Blank Presentation’.It is opened. 

Save the presentation on Lab1.pptx 

1)Select the ‘File’ on Tab Bar. 

2)Click on’Save As’ option. 

3)Click ondocument/desktop as your choice. 

4)Type the name’Lab 1.pptx. 

5)Click the’Save’ button. 

Add a Title to the first slide :the name of your college. 

1)Left click on the ‘ click to Add Title ‘ section on the first slide. 

2)Type the name of your college. 

  

Type your first name and last name in the subtitle section: 

1)Left click on the ‘click to Add Subtitle ‘ section. 

2)Type your first name and last name. 

Add a New Slide which has a Title and content. 

1)Select the Home tab. 

2) Click on the dropdown button of the ‘New Slide’on toolbar. 

3)Select the slide having ‘Title and Content’. It is added. 

 

 

Q15.Write steps for  creation of a set of  Power point slides that 

demonstrates your skill to use the tools of Powerpoint .It should include the 

following things 

 Titles slide and bullet list 

 Inserting Excel Sheet 

 Clip art and Text 

 Slide show effects 



 Ans:-Title Slide and bullet list: 

 Open PowerPoint Presentation 

 Select the Home Tab. 

 Click at the dropdown button on ‘New Slide’ at toolbar. 

 Select the slide having Title slide and Bullet list. 

 

 Inserting Excel sheet: 

 

1.Open the slide where you want to insert the Excel Sheet. 

2.Select the ‘Insert tab’.And click on ‘Object’ on tool bar. 

3.Select the ‘Microsoft  Excel Worksheet’ object type. 

4.Click the ‘Ok’ button. 

 Clip Art and Text: 

1.Select the Insert Tab. 

2.Select the ‘Pictures’or ‘Online Pictures’ on tool bar. 

3.Choose the  appropriate art for the topic. 

4.Click on the ‘Insert’ button. 

 Slide show effects: 

1.Select ‘Design Tab’ fot Themes,Variants and Slide size. 

2.Select ‘Transition Tab’ for Cut,Fade,Push,Wipe,Split,Reveal,Shape,Flash,etc 

for slide effects. 

 

Q16.What is the difference  Machine langusge and Highlevel   language? 

Ans:- 

1.This language makes fast and efficient 
use of the computer. 
 
 

1.They are programmer friendly. 

2.It requires no translator to translate the 
code.It is directly understood by the 
computer. 

2.It takes additional translation time to 
translate the source code to machine 
code. 
 

 



Q17.Discuss about different data types of C programming language. 

Ans:- The different data types in C programming language are: 

Char:The most  data types in C.It  store a single character and requires a 

single bite of memory in almost all compilers. 

 

Int:As the name suggests , as int variable is used to store an integer. 

 

Float:It is used to store decimal numbers. 

 

Double:It is used to store decimal numbers( number with floating point value 

but its range of values is high comparison to float) 

Q18.Find  the output of the following expressions 

   a)X=20/5*2+30-5     b)Y=30-(40/10+6)+10        c)Z=40*2/10-2+10 

Ans:- a)X=33 

      b)Y=30 

   C)Z=16 

Q19.Describe the syntax of the following statements. 

a) If- else statement    b)for loop      c)do- while loop 

Ans:-if  - else statement: 

If statements  can be  followed by an optional  else block of statements,which 

executes when the Bootcan  expression is false. 

Syntax 

If (expression) 

 { 

true block of statements;  



  } 

else  

{ 

else block of statements; 

} 

b)For loop is similar to while loop.Basic syntax of loop is as follows: 

For (expression 1; expression 2; expression 3) 

{ 

Block statement 

} 

In the above syntax 

Expression 1-initializes variables. 

Expression 2- conditional expression as long as  this condition is true,loop will 

keep executing. 

Expression  3-It is the modifier which will  increase or decrease the  value of the 

variable. 

c)while loop 

Basic syntax of while loop is as follows 

 While (condition) 

           Single statements 

Or While (condition) 

 { 



Block of statements 

}           

d)Do while loop. 

Do- while loop  is just like a while loop except that the text condition is checked at 

the end of the loop rather than the start.This has the effect that the body of the 

loop are always executed at the once. 

Basic syntax of do-while loop is as follows 

Do 

{ 

Single statement 

   Or  

Block of statements 

}while (condition); 

Q20.Find the output of the following program segments. 

a) b) 
 
 

c) 

#include<stdio.h> 
Int main() 
{ 
Int I; 
For(i=1;I<2;i++) 
} 
  Printf(“IMS 
Ghaziabad/n”) 
} 
} 

#include<stdio.h> 
Int main() 
{ 
  Int i=1; 
 While( 1<=2) 
{ 
  Printf(IMS  
Ghaziabad/n”); 
    } 
} 
 

#include<stdio.h> 
Void main() 
{ 
   Int  a=10, b=100; 
If (a>b) 
Printf(“Largest number is 
%d/n”,a); 
Printf(“Largest number is 
% d/n”,b); 
} 



Ans:-a) IMS Ghaziabad 

 

b)IMS  Ghaziabad 

c)b=100 

 

 

 

 

 

 

 

 

 


